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IMPORTANT INFORMATION !

This publication is an illustrated version of (SF-279) online help . Since the user can
access and print online help directly from the application, online help is considered
the primary source for information about (SF-279).

When you print online help directly from the application, the format is different from
this illustrated version; however, the text is the same. Therefore, NFC provides the
illustrated version only upon customer request.

For information about this publication, please contact NFC. Instructions for
contacting NFC and other support sources are provided in the About This
Procedure  section of this publication.

Published and printed by the National Finance Center,
U.S. Department of Agriculture, New Orleans, Louisiana
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Latest Update Information

Bulletin SF279 03-1, Update of SF-279, dated January 31, 2003, notifies users of the changes to
the SF-279 Web-based application and online help. These changes are necessary due to
Amendment 8 to the Federal Procurement Data System Reporting Manual for fiscal year 2003.

Listed below is a summary of the changes to the SF-279 procedure:

Description of Change Page

New edit for Field 2. Contract Number 20

New edit for Field 8. Report Period 22

New edit for Field 9. Kind of Contract Action 22

Field 10, Dollars Obligated or Deobligated This Action. The field has been
changed to collect whole dollars.

23

New edit for Field 12. Principal Product or Service Code 23

New edit for Field 13. Principal North America Industry Classification System
(NAICS)

24

New edit for Field 19A. Use of EPA Designated Products 27

New edit for Field 19B. Use of Recovered Material and Waste Reduction
Clauses

27

New edit for Field 20. Performance-Based Service Contracting 27-28

New edit for Field 26. Solicitation Procedures 32-33

New edit for Field 30. Type of Contractor 36

New edit for Field 33A. HUBZone Program 38

New edit for Field 33B. Small Disadvantaged Business Programs 39

New edit for Field 33C. Other Preference Programs 41

New edit for Field 36. Estimated Contract Completion Date 43

New edit for Field 41. Multiple Award Contract Fair Opportunity 45

New edit for Field 42. Demonstration Program 45-46

Deletions in the text are identified by “��”;  other changes are identified by “ ”.
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About This Procedure

This procedure provides instructions for accessing and operating the Procurement Reporting
System (SF-279). The following information will help you use the procedure more effectively
and locate further assistance if needed.

This section presents the following topics:

How The Procedure Is Organized

What Conventions Are Used

Who To Contact For Help

How The Procedure Is Organized

The major sections of this procedure are described below.

Introduction  presents an overview of (SF-279), including security access information and
instructions for accessing the system. It also provides basic operational information about
the menu bar, toolbar, function keys, system edits, online help, and hint text.

Using SF-279  provides step-by-step instructions for the adding, correcting, and deleting
processes performed in (SF-279).

Field Instructions For SF-279 Windows  contains instructions for and descriptions of the
fields on (SF-279) windows.

Heading Index  provides an alphabetical list of all headings in the procedure. When a
heading is referenced, you can use this index to locate the page number.

To keep you informed about new or changed information related to this system, NFC issues short
publications called bulletins. This procedure and all related bulletins are listed in the Publications
Catalog available on the Internet at the NFC home page (www.nfc.usda.gov). To see these listing,
go to the NFC home page and click the Pubs & Forms icon at the top of the page. At the Pubs &
Forms page left-hand menu, under Publications Catalog, click List by Acronym/Name or List by
Title/Chapter and search for the appropriate system application on the list provided.
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What Conventions Are Used

This procedure uses the following visual aids to identify certain kinds of information:

Convention Example

Messages displayed by the system
are printed in italics.

The message Transaction completed,
record saved. is displayed.

Important extra information is
identified by a note, warning, caution,
or reminder icon in the left margin.

Note

For modifications, use the same code as the
original contract.

Figure references link figures with the
text. These references are printed in
bold sans serif font.

The Logon pop-up (Figure 1 ) is displayed.

References to headings in the
procedure are printed in the same font
as figure references.

Note:  When a heading is referenced
in the procedure, you can use the
Heading Index to locate the page
number.

For instructions on this process, see Using
(SF-279).

References to menu options are
printed in bold italics .

To search (SF-279) records select:
Query > Enter.

References to command buttons or
keyboard keys are printed in bold and
enclosed in brackets.

Press [Tab]  to move to the next field.

Field names are printed in the margin.
Field specifications are printed in
italics.

Note:  Field entries are identified as
required1, conditional2, optional3,
optional default4, or no entry5.

1. Reporting
Agency Code

Required, alphanumeric, 5 positions max.
Type the reporting agency acronym.

1Required You must enter data in the field.Required You must enter data in the field.
2Conditional You may be required to enter data, based on criteria indicated in the field instructions.Conditional You may be required to enter data, based on criteria indicated in the field instructions.
3Optional You may elect to enter data in the field. If the field is left blank, no data is system generated.Optional You may elect to enter data in the field. If the field is left blank, no data is system generated.
4Optional default You may elect to enter data. If the field is left blank, the system generates a default entry.p y , y g y
5No entry You do not enter data in the field. The field instruction states the reason for no entry.

Who To Contact For Help

For help or additional information, please contact personnel as listed below.

For technical questions about SF-279 reporting or questions about unusual conditions,
contact the Office of Procurement and Property Management/Procurement Systems
Division at 202-401-4081.

For questions about the SF-279 application, contact Administrative Systems Upgrade
Branch personnel at 504-255-5514.

For access to SF-279, contact your agency’s Information Systems security officer.

Refer questions about this procedure to 504-255-5322 or via e-mail to nfc.pvct@usda.gov.
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1About (SF-279)

Introduction

This section presents the following topics:

About (SF-279)

Getting Started in (SF-279)

(SF-279)  Operating Features

About (SF-279)

The Procurement Reporting System (SF-279) is a Web-based system developed by the
Office of Procurement and Property Management (OPPM) and the National Finance
Center (NFC) with other U. S. Department of Agriculture (USDA) agency input. The
SF-279 is used to capture, enter, and query data from Form SF-279, Federal Procurement
Data System (FPDS), Individual Contract Action Report (ICAR), as well as USDA’s internal
requirements. SF-279 consists of three windows (SF 279-A, SF 279-B, and SF 279-C) and
several pop-ups.

SF-279 is used to report procurements exceeding $25,000 to the Federal Procurement Data
Center (FPDC) located in the General Services Administration, which collects, processes,
and disseminates official procurement data on Federal contracting to Congress, the Executive
branch, and the private sector.

Executive departments and agencies are responsible for collecting and reporting procurement
data to FPDS. This data is used to measure and access the following:

• Impact of Federal procurement on the nation’s economy

• Extent to which small business firms and small disadvantaged business firms are
sharing in Federal procurement

• Impact of full and open competition in the acquisition process

• Procurement policy purposes

SF-279 uses a database with current and historical (5 years) information on procurements, a
data entry and query program that runs against the database, a number of tables that provide
immediate information for data entry, and front-end edits to reduce the entry of invalid data.
Data in the SF-279 database is updated in real time with each entry.

Getting Started In (SF-279)

After you have been assigned an NFC User ID for SF-279 and have a terminal or personal
computer (PC) that is connected through your telecommunications network (Netscape
Navigator browser Version 4.0 or higher, or Microsoft Explored browser Version 4.0.1 or
higher) to the World Wide Web (WWW), you will be ready to log on to SF-279.
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This section reviews the basic starting and exiting functions, as well as information on
changing your password and using online help that is specific to SF-279.

For more information, see:

Security And Remote Terminal Usage

Starting SF-279

Changing Your Password

Exiting SF-279

Using Online Help

Security And Remote Terminal Usage

Access security is designed to prevent unauthorized use of systems and databases. To access
SF-279, you must have authorized security clearance and use a terminal or PC that is
connected through your telecommunications network to WWW.

For information about access security, including user identification numbers (user ID’s),
passwords, and obtaining access to a specific system, see the Remote Terminal Usage
procedure (Title VI, Systems Access Manual, Chapter 2, Remote Site Usage, Section 1). For
information about connecting and disconnecting from your telecommunications network, see
the instructions that are provided with your specific network.

Starting SF-279

The first time you try to log on to SF-279, at the USDA SF-279 Welcome Banner you will
be prompted to download a browser plug-in named Oracle Jinitiator.

Some browsers such as Internet Explorer may download the plug-in without prompting.

Downloading the Oracle Jinitiator Plug-in:

1. At the Plug-in Not Loaded pop-up, click [Get the Plug-in] . The Oracle Jinitiator
Download Page is displayed.

If you click [Cancel] , you may download the plug-in at a later time by selecting the
Click here link in the If you cancelled a previous Jinitiator Plug-in download, Click
here statement at the bottom of the USDA SF-279 Welcome Banner (Figure 1 ).

2. At the Oracle Jinitiator Download Page, click on Download the Oracle Jinitiator
plug-in. (Third paragraph on page and the line is underlined.) The File Download
pop-up is displayed.

3. At the File Download pop-up, select Save this program to disk, and click [OK] . The
Save As pop-up is displayed.

4. At the Save As pop-up, save the file to your desktop. The jinit.exe icon will appear on
your desktop.

5. At your desktop, double click the jinit.exe icon. The Install Shield Self-extracting EXE
pop-up is displayed.

Note

!
Caution
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6. At the Install Shield Self-extracting EXE pop-up, click [YES] . The message This will
install Oracle. Do you wish to continue? is displayed.

7. Click [YES]  and the plug-in will be installed. The installation will take a few
moments. The Oracle Jinitiator Welcome pop-up is displayed.

8. At the Oracle Jinitiator Welcome pop-up, click [Next] . Various pop-ups will be
displayed indicating the plug-in’s installation progress and completion.

9. When the installation is complete, either exit the browser or click the reload icon on
the toolbar.

To start SF-279:

1. Log on to your browser.

2. Log on to the USDA Procurement Page at http://www.usda.gov/procurement/.

a. Click the Acquisition Toolkit  icon and the Acquisition Toolkit page appears.

b. Click USDA On-line SF-279 Reporting System under Reporting Tools and a
warning message pop-up will be displayed indicating that you are logging on to a
U.S. Government computer and if you do not have authorized access to this
system to disconnect. 

OR

a. Log on to the NFC Home Page at http//www.nfc.usda.gov.

b. Click the USDA Procurement Reporting System icon under Application
Launchpad and a warning message pop-up will be displayed indicating that you
are logging on to a U.S. Government Computer and if you do not have authorized
access to this system to disconnect.

If this is the first time you are logging on to SF-279 and the Plug-in Not Loaded
pop-up is displayed, see the instructions for Downloading the Oracle Jinitiator Plug-in
above.

3. Click [OK]  and the USDA SF-279 Welcome Banner window (Figure 1 ) is displayed.
After a moment, the Logon pop-up (Figure 2 ) is displayed.

!
Caution
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Figure 1. USDA SF-279 Welcome Banner

Figure 2. Logon pop-up

4. Complete the fields as indicated under Logon Pop-up Field Instructions .

5. Click [Logon]  to log on to SF-279.
OR

Click [Cancel]  to cancel the log on.

It will take a few moments to download the SF-279 after the log on. 
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When the SF 279-A window (see Figure 4 ) appears on the screen, you are in the add
function and are ready to enter data. For more information about adding records, see Adding
An SF-279 Record . You can use the toolbar or menu bar to change to the query function. For
more information on the query function, see Searching/Viewing An SF-279 Record . For
more information on the toolbar and/or menu bar, see The SF-279 Toolbar  and/or The
SF-279 Menu Bar .

Changing Your Password

You may change your password at any time but not more than once a day. It is recommended
that you change your password at least every 30 days. To change your password:

1. At the SF 279-A (see Figure 4 ), SF 279-B (see Figure 5 ), or SF 279-C (see Figure 6 )
window, select Change Password > Change Password Screen and the Change
Password pop-up (Figure 3 ) is displayed. For more information on the menu bar, see
The SF-279 Menu Bar .

Figure 3. Change Password pop-up

2. Complete the fields as indicated under Change Password Pop-up Field Instructions .

3. After completing the fields, click [Change Password]  to save the password change and
exit the pop-up.

OR

Click [Close]  to cancel the password change and exit the pop-up.

Note
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Exiting SF-279

At the SF 279-A, SF 279-B, or SF 279-C window, select Action > Exit from the menu bar or
click  on the toolbar. For more information on the toolbar and/or menu bar, see The

SF-279 Toolbar  and/or The SF-279 Menu Bar .

At the USDA SF-279 Welcome Banner window, select File > Exit or click the [X] in the
upper right corner of the screen. 

Using Online Help

Online help is available while working in SF-279. This online help can be accessed from the
SF 279-A, SF 279-B, and SF 279-C windows.

Window-Level Help

1. At an SF-279 window, select Help > Window Help or click  for window help. For

more information on the toolbar and/or menu bar, see The SF-279 Toolbar  and/or The
SF-279 Menu Bar . The field instructions for that window will be displayed in the help
window.

For online help for SF-279 pop-ups, follow the instructions under Table Of Contents
Help  below.

2. Click on the appropriate field number to display the field instructions for that specific
field.

3. Click the [X] in the upper right corner of the screen to close the help window.

OR

Leave the help window open for future use.

Table of Contents Help

1. At an SF-279 window, select Help > Table of Contents. For more information on the
menu bar, see The SF-279 Menu Bar . The SF-279 Table of Contents will be displayed
in the help window.

2. Scroll through the table until you see the applicable heading.

3. Click the applicable heading and that section of the online help will be displayed in the
help window.

4. Click the [X] in the upper right corner of the screen to close the help window.

OR

Leave the help window open for future use.

(SF-279)  Operating Features

SF-279  is designed in JAVA providing mouse-driven, point-and-click functionality; a menu
bar; drop-down menus; a toolbar; and hyper-text links. Although SF-279 is designed for a

Note
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mouse-driven environment, certain keys and combination of keys may be used to perform
certain functions (e.g., move the cursor, enter and update data, or initiate commands). This
section reviews these basic features and describes others that are specific to SF-279.

SF-279 windows and pop-ups require you to [TAB]  to move to the next field.

For more information, see:

SF-279  Hint Text

The SF-279 Menu Bar

The SF-279 Toolbar

SF-279 Function Keys

System Edits

Data Entry Tips

List of Values Pop-Up/Drop-Down List

SF-279  Hint Text

The SF-279 has a special feature called Hint Text. When you are adding an SF-279 record
(Hint Text is not available during the query function), place the cursor inside the field and the
helpful Hint Text for that field will appear in the status line at the bottom of the screen.
Following the hint text will help you meet the field edits; however, the hint text does not
include all of the edits for that field. For a complete list of field edits, see SF 279-A Window
Field Instructions , SF 279-B Window Field Instructions , and SF 279-C Window Field
Instructions .

Examples of Hint Text:

When the cursor is in 4. Contracting Office Order Number  the hint text will be
#4 Enter 15-pos (max) contract office order no. Req if #9=E, F, G, L. Skip if #9=A, B,
C, Z, or SAP PO. No embedded spaces/spec chars. This indicates that field 4 has a
maximum of 15 alphanumeric positions and that this field cannot contain embedded
spaces or special characters. This field is a required entry if 9. Kind of Contract Action
will be coded E, F, G, or L; or you should [TAB]  through the field if 9. Kind of
Contract Action will be coded A, B, C, Z, or if a Simplified Acquisition
Procedure (SAP) purchase order (PO).

When the cursor is in 6. Action Date  the hint text will be #6 Req. Enter 6-digit date of
award (YYYYMM). Cannot be greater than current year/quarter or less than 5 years
from current FY. This indicates that field 6 is a required entry. The entry must be
numeric and entered with a 4-digit year and a 2-digit month (YYYYMM). The date
cannot be greater than the current year and quarter, or less than 5 years from the
current fiscal year (FY).

Note
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SF-279  Menu Bar

The menu bar appears below the title bar on the SF 279-A, SF 279-B, and SF 279-C
windows. Each option on the menu bar displays options for viewing and/or processing
transactions. When an option from the menu bar is selected, a drop-down menu appears
showing a list of options.

Menu Bar

Menu Bar
Options

Drop-down
Menu Options Description

Action Clear Used to clear the fields on the window. This action does not save the
new data entered.

Save Used to save the record to the database.

Print Used to print the record on the window.

Exit Used to exit SF-279.

Query Enter Used to enter the query information into the appropriate fields.

Execute Used to execute the query function.

Cancel Used to cancel the query function.

Previous Query Used to view the previous query.

Count Hits Used to count the number of records that match the query request.

Record Previous Used to view the previous record.

Next Used to view the next record.

First Record Used to view the first record.

Last Record Used to view the last record.

New Used to enter a new SF-279 record.

Help Fiscal Year
Changes

Used to access a list of the changes to SF-279 for fiscal year.

Data Entry Tips Used to access helpful hints for data entry and navigational
information.

Table of
Contents

Used to access the table of contents for online help. At the table of
contents you can link to other parts of the procedure.

Window Help Used to access online help for the current window.

Keys Used to see available function keys.

Display Error Used in troubleshooting Oracle form errors (FRM-XXXX).

Change
Password

Change
Password
Screen

Used to access the change password pop-up.

When a menu option is shaded gray, it is not available for that function and will not respond
to selection.Note



Title II, Chapter 5 Section 2
Procurement Reporting System (SF-279)

Introduction

9(SF-279) Operating Features

SF-279  Toolbar

The toolbar is a row of tool (icon) buttons located below the menu bar on the SF 279-A,
SF 279-B, and SF 279-C windows. Each tool button displays an icon that depicts its
processing function. In most cases, the tool button can be used in lieu of the menu bar. The
toolbar includes the following tool buttons:

Tool Buttons

Button Description

Clear.  Used to clear all fields on the window. This function will
not save data entered.

Save. Used to save the SF-279 record to the database.

Print.  Used to print the window.

Exit.  Used to exit SF-279.

Enter.  Used to enter the query information in to the
appropriate fields.

Execute.  Used to execute the query.

Previous.  Used to view the previous record.

Next. Used to view the next record.

First Record.  Used to view the first record.

Last Record.  Used to view the last record.

New. Used to enter a new SF-279 record.

Window Help . Used to access online help for the current
window.

When a tool button is shaded gray, it is not available for that function and will not respond to
selection.Note
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SF-279  Function Keys

Your keyboard includes the following function keys that can be used in SF-279. For a
complete list of function keys select Help > Keys  at the SF 279-A, SF 279-B, or SF 279-C
window.

Function Keys

Key Description

F4
Used to exit SF-279.

F6
Used to clear a record.

F11
Used to enter a query.

F11 + Ctrl
Used to execute a query.

Ctrl + S

Used to save a record.

Ctrl L+
Used to view a list of values.

Ctrl +
Used to add a new record.

Tab
Used to move to the next field.

Shift + Tab

Used to move to the previous field.

System Edits

Many data entries in SF-279 are subject to front-end edits. If an error occurs or if required
data is omitted, an error message will be displayed in a pop-up when you [TAB]  to the next
field. SF-279 also performs secondary edits when you [TAB]  out of the last field on each
window, and when you save the record. All errors must be corrected before the record can be
saved to the database.

Data Entry Tips

Since SF-279 has many front-end edits built into the system, it is better to enter data in field
number order and proceed in a forward manner throughout the three windows. Skipping
around the fields on a window or going from one window that is not complete to another
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window may cause problems when SF-279 edits the fields and the windows. Start with
1. Agency and continue through 24. Type Contact/Mod. Click the SF 279-B tab and enter
data, when appropriate, in fields 25. CICA Applicability through 45. Size of Small Business.
Click the SF 279-C tab and continue to enter date in fields 46A. Funding Agency through
49.Contracting Officer, when applicable.

As stated under System Edits, fields are edited when data has been entered and you [TAB]  to
the next field, when data in a field has been changed, and when you click on a tab for another
window.

Most fields allow you to continue entering data in the next field once an error message has
been received. You may not want to correct errors as they occur, but continue forward until
you have completed all three windows and then correct the fields with errors. Sometimes
trying to correct an error as it occurs can cause you to get stuck in an edit loop. You may
wish to write down the fields that are incorrect as the error messages appear so you do not
have to rely on memory.

Fields 1, 2, 5, 6, 9 through 12, 16 through 19B, 25, 32, 37 and 42 usually will not allow you
to continue entering data until the error has been corrected.

 List Of Values Pop-Up/Drop-Down List

Many fields on the SF 279-A, SF 279-B, and SF 279-C windows have a List of Values
pop-up  (many values) or Drop-down list  (2 - 3 values) feature which allows the user

to select the correct entry from a list of valid entries for that field. The List of Value Pop-up
also allows you to search/query a list of values by entering a partial value.

To use the List of Values Pop-up:

1. Click the list of values arrow  next to the field and a list of values for that field will

appear in a pop-up.

2. Select the appropriate value, then click [OK] at the bottom of the pop-up and that value
is entered into the field.

3. Press [TAB] to move to the next field.

To query the List of Values Pop-up:

1. Click  next to the field and the list of values for that field will appear in a pop-up.

2. In the Find field at the top of the pop-up, enter a partial value in front of the
% (wildcard symbol), then click [FIND]  at the bottom of the pop-up. The list of values
will display all values that begin with the characters you entered. (The wildcard option
is available on all list of values pop-ups.)

3. Select the appropriate value, then click [OK] at the bottom of the pop-up, and that
value is entered into the field.

4. Press [TAB] to move to the next field.

!
Caution
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To use the Drop-down list :

1. Click the drop-down arrow  next to the field and the drop-down list of values for

that field will appear.

2. Select the appropriate value and that value is entered into the field.

3. Press [TAB] to move to the next field.
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Using (SF-279)

This section presents the following topics:

Searching/Viewing An SF-279 Record

Adding An SF-279 Record

Correcting An SF-279 Record

Deleting An SF-279 Record

Searching/Viewing An SF-279 Record

Searching for an existing SF-279 record from the database is called querying. This function
is used to view a record, or to find a record in the database that needs to be corrected or
deleted. You may query all fields on the SF 279-A (Figure 4 ), SF 279-B (Figure 5 ), or
SF 279-C (Figure 6 ) windows.

Figure 4. SF 279-A window
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Figure 5. SF 279-B window

Figure 6. SF 279-C window

The status line at the bottom of the screen will indicate that you are in Query. Also, when in
the enter query function, all fields are shaded white. (When you are in the adding or
correcting function, fields 1 through 19B are shaded yellow or blue.)

To query an existing record:

1. At the SF 279-A window, select Query > Enter  or click . (At this time, all fields

will change to a white shading indicating that you are in the enter query function.)

Note
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2. Enter the query information into the appropriate field(s) on the SF 279-A, SF 279-B,
and SF 279-C windows that you want to use to perform your search. Complete the
fields according to the instructions under SF 279-A Window Field Instructions  ,
SF 279-B  Window Field Instructions , and SF 279-C Window Field Instructions .

The key fields (1 through 6) will be the fields most frequently used to search for or
view a record. You may enter query information into one field or several fields to
narrow the search time and the quantity of records found in the search.

Once you have entered the query information into the appropriate fields, you may
select Query > Count Hits  at any window to see how many records match your query
request. The status line will indicate how many records were retrieved. At this point,
you can go to Step 3 to execute your query and see the records or add additional query
information to limit the number of records retrieved.

3. At any window, select Query > Execute  or click . The found record will appear in

the window. If more than one record is found, navigate through the records using one
of the following methods:

• To move to the next record, select Record > Next or click 

• To move back to the previous record, select Record > Previous  or click 

• To move to the first record, select Record > First Record or click 

• To move to the last record, select Record > Last Record or click 

At this point, fields 1 through 19B will change from the white shading to the yellow
and blue shading indicating that you are no longer in the enter query function and that
you can make changes to the record. For more information on correcting a record, see
Correcting An SF-279 Record .

4. At any window, select Query > Cancel  to exit the query function.

OR

At any window, select Record > New  or click  to exit the query function and add an

SF-279 record.

OR

At any window, select Action > Clear  or click  to clear all fields.

Adding An SF-279 Record

When you connect to SF-279, the SF 279-A window is displayed and you are ready to add
an SF-279 record.

When the cursor is in a field, the status line at the bottom of the screen will indicate the hint
text for that field. For more information on hint text, see SF-279  Hint Text .

Also, when you are in the add function, fields 1 through 19B are shaded yellow or blue.
(When in the query function, all fields are white.)

Note

Note

Note
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To add a record:

1. At the SF 279-A, SF 279-B, or SF 279-C window select Record > New  or click .

The SF 279-A window (Figure 4 ) will appear.

2. At the SF 279-A window, complete the first 6 key fields according to the instructions
under SF 279-A Window Field Instructions .

Fields 1 through 7, and 9 are shaded yellow to indicate that these are primary fields
that make an SF-279 record unique.

3. In the 7. Type of Entry  field, type A, or click  to select A Original  from the

drop-down list. The value is entered into the field.

Fields 10 through 19B are shaded blue. Usually an entry is required as these fields are
needed for most types of contract actions.

When a field is shaded gray, the field should be left blank for that particular type of
contract action. The cursor will skip the gray fields and move to be next white shaded
field.

4. Complete the fields according to the instructions under SF 279-A Window Field
Instructions .

5. Click the SF 279-B tab and the SF 279-B window appears.

6. Complete the fields according to the instruction under SF 279-B Window Field
Instructions .

7. Click the SF 279-C tab and the SF 279-C window appears.

8. Complete the fields according to the instruction under SF 279-C Window Field
Instructions .

9. At an SF 279 window, select Action > Save  or click . The record must pass a final

edit of the complete record before it will be saved to the database. A pop-up window
with the message Transaction completed, record saved. will appear indicating that the
record has been saved.

10. Click [OK]. All fields will be cleared and the cursor will return to 1. Agency  ready for
you to add another record.

Correcting An SF-279 Record

The SF-279 allows you to correct an SF-279 record that has previously been entered in the
database.

If the key fields (1 through 6) are to be changed, a correcting entry cannot be processed.
Instead, the original entry must be deleted and then a new original must be submitted.

To correct a record:

1. At the SF 279-A, SF 279-B or SF 279-C window, query for the record following the
instructions under Searching/Viewing An SF-279 Record .

Note

Note

!
Caution
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2. When the correct record is displayed, [TAB] to 7. Type of Entry and type C,  or click
 to select C Correcting  from the drop-down list. The value is entered into the field.

3. Correct the appropriate fields according to the instructions under SF 279-A Window
Field Instructions , SF 279-B Window Field Instructions , and SF 279-C Window Field
Instructions , as applicable.

4. At an SF 279 window, select Action > Save  or click . The record must pass a final

edit of the complete record before the correction will be saved to the database. A
pop-up with the message SF-279 updated successfully. will appear indicating that the
corrected record has been saved.

5. Click [OK]. All fields will be cleared and the cursor will return to 1. Agency  ready for
you to add or query another record.

Deleting An SF-279 Record

The SF-279 can mark existing SF-279 records for deletion. To delete an SF-279 record, key
fields (1 through 6) must be an exact match to an existing SF-279 record in the database.

To delete a record:

1. At the SF 279-A, SF 279-B, or SF 279-C window, query for the record following the
instructions under Searching/Viewing An SF-279 Record.

2. When the correct record is displayed, [TAB] to 7. Type of Entry and type B, or click
 to select B Deleting  from the drop-down list. The value is entered into the field.

3. At an SF 279 window, select Action > Save  or click . A pop-up with the warning

message Are you sure you want to mark this record for deletion? will appear.
Select[Yes]  and all fields will be cleared and the record will be marked for deletion.
Select [No]  and you will return to the SF 279-A window.
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Field Instructions For (SF-279) Windows

This section presents the following topics:

Logon Pop-up Field Instructions

Change Password Pop-up Field Instructions

SF 279-A Window Field Instructions

SF 279-B Window Field Instructions

SF 279-C Window Field Instructions

Logon Pop-up Field Instructions

The Logon pop-up (Figure 2 ) is used to log on to SF-279. For more information on logging
on, see Starting SF-279 .

Username
Type your NFC user identification number.

Password
Type your unique password.

Change Password Pop-up Field Instructions

The Change Password pop-up (Figure 3 ) is used to change your password. For more
information on changing your password see, Changing Your Password .

Old Password
Type your current password.

New Password
Type your new password.

Confirm
Type the new password again to confirm it was entered as intended.

SF 279-A Window Field Instructions

The SF 279-A window (Figure 4 ) is used to search/view, add, correct, or delete SF 279 data.
For instructions on this process, see Searching/Viewing An SF-279 Record , Adding An SF-279
Record , Correcting An SF-279 Record , or Deleting An SF-279 Record , as applicable.

Required, alphanumeric, 20 positions max.

Required, alphanumeric, 6 - 20 positions

Required, alphanumeric, 6 - 20 positions

Required, alphanumeric, 6 - 20 positions

Required, alphanumeric, 6 - 20 positions
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1. Reporting
Agency Code

Type the reporting agency acronym (i.e., ARS, APHIS, OO ) or click  to

select a code from the pop-up list of values, if not system generated or if agency
acronym is incorrect. Click [OK]  and the value selected is entered into the field.
For information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

2. Contract
Number

Type the unique contract or purchase order number. For Simplified Acquisition
Procedures (SAP) enter the purchase order number. Ensure that there are no
embedded spaces or special characters.

To verify the schedules data beginning with GS, go to the General Services
Administration (GSA) Federal Supply Schedules page at
http://www.fss.gsa.gov/schedules. Click Schedules E-Library.

If: Action for 2. Contract Number:

9. Kind Of Contract Action
is coded C (New Definitive
Contract)

The contract number cannot be reported
more than once by the same agency.

9. Kind Of Contract Action
is coded G (Order/Mod Under
Federal Schedule Contract)

Must be on the Federal Schedules Contract
File.

Must begin with GS or V.

If Item 2 begins with GS, the contract
number must not contain alpha O, the third
and forth positions must be numeric, and
the fifth position must be F or K.

If Item 2 begins with GS and the fifth
position is F, the contract number must have
10 digits and the tenth post must be an
alpha character.

If Item 2 begins with GS and the fifth
position is K, then the contract number must
have 14 digits and the tenth digit must be S.

�If the contract number is on the Federal
Schedule Table, Item 9 must be coded G
except for codes J, K, and Z.�

3. Modification
Number

Type the modification number. Ensure that there are no embedded spaces or
special characters.

Report terminations as modifications.

If 9. Kind Of Contract Action is coded: Action for 3. Modification Number:

A (Initial Letter Contract),
C (New Definitive
Contract),or D (Purchase
Order/BPA Calls Using SAP)

Skip this field.

Required, alphanumeric, 5 positions max.

Required, alphanumeric, 8 - 15 positions

Note

Conditional, alphanumeric, 4 positions max.

Reminder
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B (Definitive Contract
Superseding Letter
Contract), E (Order Under
Single Award Indefinite
Delivery Contract), F (Order
Under Basic Ordering
Agreement), G (Order/
Modification Under Federal
Schedule Contract), L (Order
Under Multiple Award
Contract), or Z (Initial
Load of Federal Schedule
Contract)

This field may be blank.

H (Modification),
J (Termination for Default),
or K (Termination for
Convenience)

Type the modification number.

4. Contracting
Office Order
Number

Type the contract office order number. Ensure that there are no embedded spaces
or special characters.

If 9. Kind Of Contract Action is coded: Action for 4. Contracting Office Order
Number:

A (Initial Letter Contract) Skip this field.

B (Definitive Contract
Superseding Letter Contract)

Skip this field.

C (New Definitive Contract) Skip this field.

D (Purchase Order/BPA Calls
Using Simplified Acquisition
Procedures)

Field may be blank.

E (Order Under Single Award
Indefinite Delivery
Contract)

Type the contract office order number.

F (Order Under BOA) Type the contract office order number.

G (Order/Modification Under
Federal Schedule Contract)

Type the contract office order number.

L (Order Under Multiple
Award Contract)

Type the contract office order number.

Z (Initial Load of Federal
Schedule Contract)

Skip this field.

SAP Purchase Order Skip this field.

5. Contracting
Office Code

Type the purchasing or contracting office code or click  to select a code from

the pop-up list of values. Click [OK]  and the value is entered into the field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Conditional, alphanumeric, 15 positions max.

Required, alphanumeric, 5 positions
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6. Action Date
Type the date (YYYYMM) of the award action. This date cannot be greater than
the current year/quarter or less than 5 years from the current fiscal year (FY).

7. Type Of Data
Entry

Type the data entry code or click  to select a code from the drop-down list.

The value selected is entered into the field. The system defaults to A, Original.

Code Type Of Data Entry

A Original

B Deleting

C Correcting

If 7. Type Of Data Entry is coded: Action:

A Key fields (1 through 6) must not have a
duplicate entry.

B or C Key fields (1 through 6) must match the
database record.

8. Report Period
The report period (FY/quarter) is system generated based on 6. Action Date .
�The report period cannot be a date earlier than  6. Action Date �

9. Kind Of
Contract Action

Type the contract action code or click  to select a code from the pop-up list of

values. Click [OK]  and the value is entered into the field. For information on the
search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Code Kind Of Contract Action

A Initial Letter Contract

B Definitive Contract Superseding Letter Contract

C New Definitive Contract

D Purchase Orders/BPA Calls Using SAP

E Order Under Single Award Indefinite Delivery Contract

F Order Under Basic Ordering Agreement (BOA)

G Order/Modification Under Federal Schedule Contract

H Modification

J Termination for Default

K Termination for Convenience

L Order Under Multiple Award Contract

Z Initial Load of Federal Schedule Contract

If 9. Kind Of Contract Action
is coded:

Action for 25. CICA Applicability:

D �Must equal B (Purchase Orders/BPA
Calls Using SAP), E (Commercial Item
Acquisition Procedures Under Test
Program), or left blank if 18. Contract For
Foreign Govt. Or International Organization
equals Y.�

Required, numeric, 6 positions

Required, alpha, 1 position

No entry

Required, alpha, 1 position
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10. Dollars
Obligated Or
Deobligated This
Action

�Type the amount obligated or deobligated for this action with leading zeros as
necessary (i.e., $245,246.90 will be 245, 247, rounding will be to the nearest
whole dollar ).� **

If 9. Kind Of Contract Action is coded: Action for 10. Dollars Obligated Or
Deobligated This Action:

Z (Initial Load of Federal
Schedule Contract)

Skip this field.

Total Oblig
Amount

This amount is system generated based on the obligated and deobligated amounts
entered for this contract.

11. Type Of
Obligation

Type A (Obligated) or B (Deobligated) or click  to select a code from the

drop-down list. The value selected is entered into the field. The system defaults
to A.

If: Action:

9. Kind Of Contract Action
is coded Z (Initial Load of
Federal Schedule Contract)

Skip 11. Type Of Obligation.

11. Type Of Obligation is
coded B

2. Contract Number must match a contract
in the database.

12. Principal
Product Or
Service
Code (PSC)

Type the principle PSC or click  to select a code from the pop-up list of values

from the FPDS Product and Service Codes Manual. Click [OK]  and the value is
entered into the field. For information on the search feature of the pop-up, see List
of Values Pop-Up/Drop-Down List .

If: Action for 12. Principal Product Or
Service Code:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

Must not  start with A.

9. Kind Of Contract Action
is coded Z (Initial Load of
Federal Schedule Contract)

Must be valid code from PSC.

20. Performance-Based
Service Contracting is coded
Y (yes)

�Must  begin with A through Z (excluding
C , or S1) for action dates between
October 2000 and September 2001.

Must begin with A through Z (excluding C,
S1, or Y) if starting with action date
October  2001.�

Conditional, numeric, 11 positions max.

No entry

Conditional, alpha, 1 position

Conditional, alphanumeric, 4 positions
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13. Principal
North American
Industry
Classification
System (NAICS)
Code

Type a valid Principal NAICS code or click  to select a code from the pop-up

list of values. Click [OK]  and the value is entered into the field. For information
on the search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

The list of values pop-up includes a crosswalk between Principal Standard
Industrial Classification (SIC) code and the NAICS codes.

If: Action for 13. Principal NAICS Code:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

Field may be blank.

20. Performance-Based
Service Contracting is
coded Y (yes)

�NAICS must not  begin with 233 (except
for 233110), 234, 236, or 237 (except for
237210) in the first three positions.�

14. Commercial
Item Acquisition
Procedures

Type Y (yes) or N (no), or click  to select a code from the drop-down list. The

value selected is entered into the field. The system defaults to N.

If 14. Commercial Item Acquisition
Procedures is coded:

Action:

Y (yes) 25. CICA Applicability must be
coded E (Commercial Item Acquisition
Procedures Under Test Program).

Y and  18. Contract For
Foreign Govt. Or
International Org. is
coded N (no)

24. Type Of Contract Or Modification must be
coded J (Fixed-Price) or K (Fixed-Price With
Economic Price Adjustment).

Y and  18. Contract For
Foreign Govt. Or
International Org. is
coded Y

Skip 24. Type Of Contract Or Modification.

15. Contractor
Name

The contractor name is system generated based on 16. Contractor Identification
Number (DUNS) .

If a DUNS is typed in 16. Contractor Identification Number (DUNS)  that is not on
the database, type the contractor name. The new contractor name and DUNS will
be added to the database for future use.

16. Contractor
Identification
Number (DUNS)

Type the contractor’s DUNS number. The DUNS must pass the check digit
algorithm. If the DUNS number is not in the database, you will have to also
complete 15. Contractor Name .

Conditional, numeric, 6 positions

Note

Conditional, alpha, 1 position

Required, alphanumeric, 30 positions max.

Note

Required, numeric, 9 positions
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17A. Principal
Place Of
Performance

Type the principal place of performance code if United States or outlying areas
(FIPS 55), or enter search criteria in the City, State, or ZIP fields, then click 

to select a code from the pop-up list of values. Click [OK]  and the value is entered
into the field. For information on the search feature of the pop-up, see List of
Values Pop-Up/Drop-Down List . When the place of performance code is entered
the City, State, and ZIP fields will be system generated based on the code.
These fields will also be completed when selecting from the list of values pop-up.

If: Action for 17A. Principal Place Of
Performance:

Place of performance is a
foreign country

Skip this field and complete 17B. Foreign
Country.

9. Kind Of Contract Action
is coded Z (Initial Load
of Federal Schedule
Contract)

Skip this field.

City
Type a full or partial city or county name and click  by Place of Performance

to select a code from the pop-up list of values. Click [OK]  and the value is entered
into the field. For information on the search feature of the pop-up, see List of
Values Pop-Up/Drop-Down List .

State
Type the state abbreviation and click  by Place of Performance to select a code

from the pop-up list of values. Click [OK]  and the value is entered into the field.
For information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

ZIP
Type a full or partial ZIP code and click  by Place of Performance to select a

code from the pop-up list of values. Click [OK]  and the value is entered into the
field. For information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

17B. Foreign
Country

Type the foreign country code (FIPS 10) or click  to select a code from the

pop-up list of values. Click [OK]  and the value is entered into the field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

If: Action for 17B. Foreign Country:

Place of performance is the
United States

Skip this field. US will be system generated
based of 17A. Principal Place of
Performance.

9. Kind Of Contract Action
is coded Z (Initial Load of
Federal Schedule Contract)

Skip this field.

Conditional, numeric, 7 positions

Optional, alphanumeric, 20 positions max.

Optional, alpha, 2 positions

Optional, numeric, 5 positions max.

Conditional, alpha, 2 positions
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If you entered a DUNS which represents Federal Industries (i.e., UNICOR) in
16. Contractor Identification Number (DUNS) , the cursor skips fields 18 through
46 and moves to the Agency Specific area on the SF 279-C window for possible
optional entries.

18. Contract For
Foreign Govt. Or
International
Organization

Type Y (yes) or N (no), or click  to select a code from the drop-down list. The

value selected is entered into the field.

If: Action:

9. Kind Of Contract Action
is coded Z (Initial Load of
Federal Schedule Contract)

Skip 18. Contract For Foreign Govt. Or
International Organizaiton.

18. Contract For Foreign
Govt. Or International
Organization is coded Y

Skip fields 19 through 35, and 40 through
45.

19A. Use of
EPA-Designated
Products

Type the code for the Environmental Protection Agency (EPA) -designated
products with a required minimum recovered material content or click  to

select a code from the pop-up list of values, otherwise skip this field. Click [OK]
and the value is entered into the field. For information on the search feature of the
pop-up, see List of Values Pop-Up/Drop-Down List .

The Resource Conservation and Recovery Act, Section 6002, and Executive
Order 13101 require the purchase of EPA-designated products with a required
minimum recovered material content as described in an agency’s Affirmative
Procurement Program. The list of EPA-designated products is available at
http://www.epa.gov/cpg.

If more than one exception applies or more than one justification was completed,
report the predominant exception code or the code for the highest cost
EPA-designated item for which a justification was completed.

Code Description of EPA-Designation

A Product or products were purchased and all contained the required
minimum recovered material content

B Product or products were purchased without the required minimum
recovered material content and a justification was completed based on
inability to acquire the product(s) competitively within a reasonable
time (FAR 23.405(c)(1))

C Product or products were purchased without the required minimum
recovered material content and a justification was completed based on
inability to acquire the product(s) at a reasonable price
(FAR 23.405(c)(2))

D Product or products were purchased without the required minimum
recovered material content and a justification was completed based on
inability to acquire the product(s) to reasonable performance
standards in the specifications (FAR 23.405(c)(3))

E Products or products purchased were not EPA-designated

Note

Conditional, alpha, 1 position

Conditional, alpha, 1 position

Note

!
Caution
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If: Action for 19A. Use of
EPA-Designated Products

9. Kind Of Contract Action
is coded Z �(Initial Load of
Federal Schedule Contract
only by GSA or VA) �

Skip this field.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip this field.

19B. Use of
Recovered
Material and
Waste Reduction
Clauses

When 19A. Use of EPA-Designated Products  is coded A through D, type the code
for the appropriate recovered material and waste reduction clause, or click  to

select a code from the pop-up list of values, otherwise skip this field. Click [OK]
and the value is entered into the field. The system defaults to B, No clause.

Code Recovered Material and Waste Reduction Clauses

A Recovered Material and Waste Reduction Clauses (Report this code
only if the contract includes FAR 52.223-4, Recovered Material
Certification, or FAR 52.223-4 and FAR 52.223-9, Estimate of
Percentage of Recovered Material Content for EPA-Designated
Products or FAR 52.223.10, Waste Reduction Program.)

B No clause included in the contract.

If: Action for 19B. Use of Recovered
Material and Waste Reduction
Clauses

�9. Kind Of Contract Action is coded
G (Order/Modification Under
Federal Schedule Contract)

�Must  be blank.

9. Kind Of Contract Action is coded Z Must be A, B, or blank.

19A. Use of EPA Designated Products
is coded E or blank �

Must be A or B.�

20. Performance-
Based Service
Contracting
(PBSC)

Type Y (yes), N (no), �leave  blank,� or click  to select a code from the

drop-down list. The value selected is entered into the field.

PBSC applies to �certain� service codes. The dollar threshold for reporting
PBSC is for procurement actions with an estimated value over $25,000, and the
action date is equal to or greater than October 1, 2000.

If: Action:

9. Kind Of Contract Action
is coded Z �(Initial Load of
Federal Schedule Contract
only by GSA or VA) �

Skip 20. Performance-Based Service
Contracting.

Conditional, alpha, 1 position

Conditional, alpha, 1 position

Note
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 12. Principal PSC begins
with A through Z (except for
C, S1, and Y)

20. Performance-Based Service
Contracting must be coded Y.

12. Principal PSC is numeric
or �if service code begins
with C, S1, or Y �

�Starting with action date October 2001,
must  be blank.�

18. Contract For Foreign
Govt. Or International
Organization is coded
Y (yes)

Skip 20. Performance-Based Service
Contracting.

20. PBSC is coded Y �Starting with Action Date October
2001,� Must begin with A through Z
(excluding C and S1,  or Y).

NAICS Code must not  begin with 233
(except for 233110), 234, �236, or 237
(except for 237210)� in the first three
positions.

�Between Action Date October 2000
through September 2001, PSC must begin
with A through Z (excluding C and S1),
otherwise N. �

Action Date must be equal to or greater
than October 2000 (200010).

�Must be blank if Action Date is less than
October 2000.�

21. Bundling Of
Contract
Requirements

Type Y (yes) or N (no), or click  to select a code from the drop-down list. The

value selected is entered into the field. 

For modification, use the same code as the original contract.

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

21. Bundling Of Contract Requirements
may be blank.

18. Contract For Foreign
Govt. Or International
Organization is
coded Y (yes)

Skip 21. Bundling Of Contract
Requirements.

21. Bundling Of Contract
Requirements is coded Y

6. Action Date must be equal to or greater
than October 2000 (200010).

22. Country Of
Manufacture

Type the foreign country code (FIPS 10) or click  to select a code from the

pop-up list of values. Click [OK]  and the value is entered into the field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Conditional, alpha, 1 position

Reminder

Conditional, alpha, 2 positions
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If: Action for 22. Country Of
Manufacture:

9. Kind Of Contract Action
is coded Z (Initial Load of
Federal Schedule Contract)

Skip this field.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip this field.

23. Synopsis Of
Procurement
Prior To Award

Type appropriate code to indicate the synopsis requirements of FAR Subpart 5.2
for this procurement prior to award or click  to select a code from the pop-up

list of values. Click [OK]  and the value is entered into the field. For information
on the search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Use code A if a combined synopsis/solicitation of the proposed action was
prepared in accordance with FAR Subpart 12.603.

Use code D if your agency is participating in the SBA/OFPP Pilot Program that
allows for the waiver of the synopsis requirement in the FAR Subpart 5.2 when
agencies acquire services valued between $25,000 and $100,000 from small
business under set-asides. If the acquisition is subject to the Small Business
Competitive Demonstration Test Program, code D cannot be used.

Code Synopsis Of This Procurement Prior To Award

A Synopsized Prior to Award

B Not Synopsized Due to Urgency

C Not Synopsized for Other Reasons

D Not Synopsized Under the SBA/OFPP Waiver Pilot Program

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

23. Synopsis Of This Procurement Prior To
Award may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 23. Synopsis Of This Procurement
Prior To Award.

Conditional, alpha, 1 position

Note

Note
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23. Synopsis Of Procurement
Prior To Award is coded B
and  25. CICA Applicability
is coded A (CICA Applicable)

27. Authority For Other Than Full And
Open Competition must be coded
H (Urgency).

23. Synopsis Of Procurement
Prior To Award is coded D

9. Kind Of Contract must be D (Purchase
Orders/BPA Calls Using Simplified
Acquisitions Procedures).

10. Dollars Obligated Or Deobligated must
be equal to or less than $100,000.

12. Principal Product or Service Code must
begins with A through Z, except for E.

30. Type Of Contractor must be coded
A (SDB) or B (Other Small Business).

42. Demonstration Program must be N (no)
or blank.

24. Type Of
Contract Or
Modification

Type the type of contract or modification code or click  to select a code from

the pop-up list of values. Click [OK]  and the value is entered into the field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Code Type Of Contract Or Modification

A Fixed-Price Redetermination

J Firm Fixed-Price

K Fixed-Price with Economic Price Adjustment

L Fixed-Price Incentive

R Cost-Plus-Award-Fee

S Cost - No Fee

T Cost Sharing

U Cost-Plus-Fixed-Fee

V Cost-Plus-Incentive

Y Time and Materials

Z Labor Hour

If: Action for 24. Type Of Contract Or
Modification:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

Field may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip this field.

Conditional, alpha, 1 position
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SF 279-B Window Field Instructions

The SF 279-B Field Instructions window (Figure 5 ) is used to search/view, add, correct, or
delete SF 279 data. For instructions on this process, see Searching/Viewing An SF-279 Record ,
Adding An SF-279 Record , Correcting An SF-279 Record , or Deleting An SF-279 Record , as
applicable.

Competition

25. CICA
Applicability

Type the CICA applicability code or click  to select a code from the pop-up

list of values. Click [OK]  and the value is entered into the field. For information
on the search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Code CICA Applicability

A CICA Applicable

B Purchase Orders/BPA Calls Using SAP

C Subject to Statute Other Than CICA

D Pre-CICA

E Commercial Item Acquisition Procedures Under Test Program

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

25. CICA Applicability may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 25. CICA Applicability.

25. CICA Applicability is
coded A

6. Action Date must be greater than
March 1985.

25. CICA Applicability is
coded B

9. Kind Of Contract Action must be
coded D (Purchase Orders/BPA Calls
Using SAP), H (Modification),
J (Termination for Default), or
K (Termination for Convenience).

Skip 26. Solicitation Procedures.

Skip 27. Authority For Other Than Full And
Open Competition.

Skip 28. Number Of Offers Received.

34. Subcontracting Plan must be
coded B (Not Required).

∇

Conditional, alpha, 1 position.
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25. CICA Applicability is
coded C or D

Skip 26. Solicitation Procedures.

Skip 27. Authority For Other Than Full And
Open Competition.

Skip 28. Number Of Offers Received.

25. CICA Applicability is
coded E

14. Commercial Item Acquisition
Procedures must be coded Y (yes).

Skip 26. Solicitation Procedures.

Skip 27. Authority For Other Than Full And
Open Competition.

28. Number Of Offers Received must be
completed .

34. Subcontracting Plan must be
completed .

26. Solicitation
Procedures

When 25. CICA Applicability  is coded A (CICA Applicable), type the solicitation
procedure code or click  to select a code from the pop-up list of values.

Click [OK]  and the value is entered into the field, otherwise skip this field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Code Solicitation Procedures

A Full and Open Competition - Sealed Bid

B Full and Open Competition - Competitive Proposal

C Full and Open Competition - Combination

D Architect-Engineer Procedures

E Basic Research

F Multiple Award Schedule

G Alternative Sources

K Set-Aside

L Other Than Full and Open Competition

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

26. Solicitation Procedures may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 26. Solicitation Procedures.

26.Solicitation Procedures
is coded A, B or C

Skip 27. Authority For Other Than Full And
Open Competition.

29. Extent Competed must be
coded A (Competed Action).

�33B. Small Disadvantaged Business
Programs must be coded D (SDB Price
Evaluation Adjustment), E (SDB
Participation Program), or F (Not
Applicable).�

Conditional, alpha, 1 position
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�26.Solicitation Procedures
is coded A, B, C, E, F, or
G�

�33A. HUBZone Program must be
coded C (HUBZone Price Evaluation
Preference), D (Combined HUBZone
Preference/SDB Price Adjustment), or
E (Not Applicable).�

26. Solicitation Procedures
is coded D

12. Principal PSC must be entered .

Skip 27. Authority For Other Than Full And
Open Competition.

29. Extent Competed must be
coded A (Competed Action).

33A. HUBZone Program must not be
coded �A (Completed Action)
C (HUBZone Price Evaluation Preference),
D (Combined HUBZone Preference/SDB
Price Adjustment) **. �

� 33B. Small Disadvantaged Business
Programs must not be coded D (Combined
HUBZone Preference/SDB Price
Adjustment).�

26. Solicitation Procedures
is coded E

12. Principal PSC must begin with A.

Skip 27. Authority For Other Than Full And
Open Competition.

29. Extent Competed must be
coded A (Competed Action).

33A. HUBZone Program must be
coded C (HUBZone Price Evaluation
Preference), D (Combined HUBZone
Preference/SDB Price Adjustment), or
E (Not Applicable).

26. Solicitation Procedures
is coded F and G

Skip 27. Authority For Other Than Full And
Open Competition.

29. Extent Competed must be
coded A (Competed Action).

33A. HUBZone Program must be
coded C (HUBZone Price Evaluation
Preference), D (Combined HUBZone
Preference/SDB Price Adjustment), or
E (Not Applicable).

26. Solicitation Procedures
is coded K

Skip 27. Authority For Other Than Full And
Open Competition.

29. Extent Competed must be
coded A (Competed Action).

30. Type Of Contractor must be
coded A (SDB) or B (Other Small
Business).

26. Solicitation Procedures
is coded L

27. Authority For Other Than Full And
Open Competition must be completed .

27. Authority For
Other Than Full
And Open
Competition

When 26. Solicitation Procedures  is coded L (Other Than Full and Open
Competition), type the authority for other than full and open competition or
click  to select a code from the pop-up list of values. Click [OK]  and the value

is entered into the field, otherwise skip this field. For information on the search
feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Conditional, alpha, 1 position
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Code Authority For Other Than Full And Open Competition

A Unique Source

B Follow-up Contract

C Unsolicited Research Proposal

D Patent/Data Rights

E Utilities

F Standardization

G Only One Source - Other

H Urgency

J Mobilization, Essential R & D Capability or Expert Services

L International Agreement

M Authorized by Statute

N Authorized for Resale

P National Security

Q Public Interest

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

27. Authority For Other Than Full And
Open Competition may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 27. Authority For Other Than Full And
Open Competition.

25. CICA Applicable is
coded B (Purchase Orders/BPA
Calls Using SAP), C (Subject
to Statute Other Than CICA),
D (Pre-CICA), or
E (Commercial Item
Acquisition Procedures Under
Test Program)

Skip 27. Authority For Other Than Full And
Open Competition.

27. Authority For Other Than
Full And Open Competition is
coded C

12. Principal PSC must begin with A.

27. Authority For Other Than
Full And Open Competition is
coded N

29. Extent Competed must be
coded B (Not Available for Competition).

28. Number Of
Offers Received

When 25. CICA Applicability  is coded A (CICA Applicable) or E (Commercial
Item Acquisition Procedures Under Test Program) type the code for the number
of offers received or click  to select a code from the pop-up list of values.

Click [OK]  and the value is entered into the field, otherwise skip this field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Code Number Of Offers Received

A 1 Offer

B 2 - 5 Offers

Conditional, alpha, 1 position
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C 6 - 10 Offers

D 11 - 15 Offers

E 16 - 20 Offers

F 21 - 50 Offers

G Over 50 Offers

If: Action for 28. Number Of Offers
Received:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

Field may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip this field.

29. Extent
Competed

Type the extent competed code or click  to select a code from the pop-up list

of values. Click [OK]  and the value is entered into the field. For information on
the search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Code Extent Competed

A Competed Action

B Not Available for Competition

C Follow-on to Competed Action

D Not Competed

If: Action for 29. Extent Competed:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

Field may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip this field.

HUBZone/Preference
Program

30. Type Of
Contractor

Type the type of contractor code or click  to select a code from the pop-up list

of values. Click [OK]  and the value is entered into the field. For information on
the search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Code Type Of Contractor

A Small Disadvantaged Business (SDB)

B Other Small Business

C Large Business

D JWOD Nonprofit Agency

Conditional, alpha, 1 position

∇

Conditional, alpha, 1 position
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E Educational Institution

F Hospital

G Nonprofit Organization

K State/Local Government

L Foreign Contractor

M Domestic Contractor Performing Outside US

U Historically Black College/University or Minority Institution (HBCU/MI)

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

30. Type Of Contractor may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 30. Type Of Contractor.

30. Type Of Contractor is
coded M

17B. Foreign Country must be completed
(except when 9. Kind Of Contract Action is
coded G (Order/Modification Under
Federal Schedule Contract).

30. Type Of Contractor is
coded U

16. Contractor Identification Number
(DUNS) must be a valid HBCU/MI.

30. Type Of Contractor is
coded U

16. Contractor Identification Number
(DUNS) must be a valid HBCU/MI.

�30. Type Of Contractor is
coded B through M �

�33B. Small Disadvantaged Business
Programs cannot  be coded A through D.�

31.
Women-Owned
Business

Type Y (yes) or N (no), or click  to select a code from the drop-down list. The

value selected is entered into the field.  The system defaults to N.

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

31. Women-Owned Business may be
blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 31. Women-Owned Business.

31. Women-Owned Business is
coded Y

30. Type Of Contractor must be
coded A (SDB), B (Other Small Business),
or C (Large Business).

32. HUBZone
Small Business
Concern

Type Y (yes) or N (no), or click  to select a code from the drop-down list. The

value selected is entered into the field. The system defaults to N.

If coded Y, the DUNS in 16. Contractor Identification Number must match the
DUNS on the SBA HUBZone File.

Conditional, alpha, 1 position

Conditional, alpha, 1 position

!
Caution
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If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

32. HUBZone Small Business Concern
may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 32. HUBZone Small Business
Concern.

32. HUBZone Small Business
is coded Y

30. Type Of Contractor must be
coded A (SDB) or B (Other Small
Business).

32. HUBZone Small Business
is coded N

33A. HUBZone Program must be
coded E (Not Applicable).

33B. Small Disadvantaged Business
Programs must not be coded B  (8(a) with
HUBZone Priority).

33A. HUBZone
Program

Type the HUBZone program code or click  to select a code from the pop-up

list of values. Click [OK]  and the value is entered into the field. For information
on the search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Code HUBZone Program

A HUBZone Sole Source

B HUBZone Set-Aside

C HUBZone Price Evaluation Preference

D Combined HUBZone Preference/SDB Price Adjustment

E Not Applicable

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

33A. HUBZone Program may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 33A. HUBZone Program.

Conditional, alpha, 1 position
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33A. HUBZone Program is
coded A

25. CICA Applicability must be
coded A (CICA Applicable).

26. Solicitation Procedures must be
coded L (Other Than Full and Open
Competition).

27. Authority For Other Than Full And
Open Competition must be
coded M (Authorized by Statute).

30. Type Of Contractor must be
coded A (SDB) or B (Other Small
Business).

32. HUBZone Small Business Concern
must be coded Y (yes).

33B. Small Disadvantaged Business
Programs must not  be coded A (8(a)
Contract Award or B (8(a) with HUBZone
Priority).

Skip 33C. Other Preference Programs.

33A. HUBZone Program is
coded B

30. Type of Contractor must be
coded A (SDB) or B (Other Small
Business).

32. HUBZone Small Business Concern
must be coded Y (yes).

  33B. Small Disadvantaged Business
Programs must not  be coded A (8(a)
Contract Award or B (8(a) with HUBZone
Priority).

Skip 33C. Other Preference Programs.

33A. HUBZone Program is
coded C

33B. Small Disadvantaged Business
Programs must not  be coded A (8(a)
Contract Award or B (8(a) with HUBZone
Priority).

Skip 33C. Other Preference Programs.

33D. HUBZone Price Evaluation
Preference Percent Difference must be
greater than 00  percent.

33A. HUBZone Program is
coded D

�30. Type of Contractor must be coded
A.�

32. HUBZone Small Business Concern
must be coded Y (yes). 

33B. Small Disadvantaged Business
Programs must be coded D (SDB Price
Evaluation Adjustment).

Skip 33C. Other Preference Programs.

33D. HUBZone Price Evaluation
Preference Percent Difference must be
greater than 00  percent.

33E. SDB Price Evaluation Adjustment
Percent Difference must be greater than
00 percent.

33B. Small
Disadvantaged
Business
Programs

Type the small disadvantaged business program code or click  to select a code

from the pop-up list of values. Click [OK]  and the value is entered into the field.

Conditional, alpha, 1 position
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For information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Code Small Disadvantaged Business (SDB) Programs

A 8(a) Contract Award

B 8(a) with HUBZone Priority

C SDB Set-Aside

D SDB Price Evaluation Adjustment

E SDB Participation Program

F Not Applicable

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

33B. Small Disadvantaged Business
Programs may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 33B. Small Disadvantaged Business
Programs.

33B. Small Disadvantaged
Business Program is coded A

29. Extent Competed must be
coded A (Competed Action) or B (Not
Available for Competition) � or C. �

30. Type Of Contractor must be
coded A (SDB), �cannot equal B through
M. �

33A. HUBZone Program must not  be
coded A (HUBZone Sole Source),
B (HUBZone Set-Aside), C (HUBZone
Price Evaluation Preference), or
D (Combined HUBZone Preference/SDB
Price Adjustment).

Skip 33C. Other Preference Programs.

33B. Small Disadvantaged
Business Program is coded B

29. Extent Competed must be
coded A (Competed Action) or B (Not
Available for Competition) � or C.�

30. Type Of Contractor must be
coded A (SDB), �cannot equal B through
M. �

32. HUBZone Small Business Concern
must be coded Y (yes).

33A. HUBZone Program must not  be
coded A (HUBZone Sole Source),
B (HUBZone Set-Aside), C (HUBZone
Price Evaluation Preference), or
D (Combined HUBZone Preference/SDB
Price Adjustment).

Skip 33C. Other Preference Programs.

33B. Small Disadvantaged
Business Program is coded C

30. Type Of Contractor must be
coded A (SDB), �cannot equal B through
M. �

Skip 33C. Other Preference Programs.
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33B. Small Disadvantaged
Business Program is coded D

Skip 33C. Other Preference Programs.

33E. SDB Price Evaluation Adjustment
Percent DIfference must be greater than
00 percent.

Item 30 (Type of Contractor) cannot equal
B through M.

33B. Small Disadvantaged
Business Program is coded E

Skip 33C. Other Preference Programs.

33C. Other
Preference
Programs

Type the other preference program code or click  to select a code from the

pop-up list of values. Click [OK]  and the value is entered into the field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Code Other Preference Programs

A Directed to JWOD Nonprofit Agency

B Small Business Set-Aside

C Buy Indian

D No Preference/Not Listed

E Very Small Business Set-Aside

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

33C. Other Preference Programs may be
blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 33C. Other Preference Programs.

33A. HUBZone Program is
coded A (HUBZone Sole
Source), B (HUBZone
Set-Aside), C (HUBZone Price
Evaluation Preference) or
D (Combined HUBZone
Preference/SDB Price
Adjustment)

Skip 33C. Other Preference Programs.

33B. Small Disadvantaged
Business Programs is
coded A (8(a) Contract
Award), B (8(a) with HUBZone
Priority), C (SDB
Set-Aside), D (SDB Price
Evaluation Adjustment), or
E (SDB Participation
Program)

Skip 33C. Other Preference Programs.

33C. Other Preference
Programs is coded A

30. Type Of Contractor must be
coded D (JWOD Nonprofit Agency).

33C. Other Preference
Programs is coded B

30. Type Of Contractor must be
coded A (SDB) or B (Other Small
Business).

Conditional, alpha, 1 position
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33C. Other Preference
Programs is coded C

30. Type Of Contractor must be
coded A (SDB).

33C. Other Preference
Programs is coded D

33A. HUBZone Program must be
coded E (Not Applicable).

33B. Small Disadvantaged Business
Programs must be coded F (Not
Applicable).

33D. HUBZone Price Evaluation
Preference Percent Difference must be
coded 00 percent or blank .

33E. SDB Price Evaluation Adjustment
Percent Difference must be coded 00
percent or blank .

�33C. Other Preference
Programs is coded A through
E�

�33D. HUBZone Price Evaluation
Preference Percent Difference must be
coded 00 percent or blank .

33E. SDB Price Evaluation Adjustment
Percent Difference must be coded 00
percent or blank .�

33C. Other Preference
Programs is coded E

30. Type Of Contractor must be
coded A (SDB) or B (Other Small
Business).

10. Dollars Obligated Or Deobligated This
Action cannot  be greater than $50,000.

33D. HUBZone
Price Evaluation
Preference
Percent
Difference

When 9. Kind of Contact Action  is coded A (Initial Letter Contract),C (New
Definitive Contract), or D (Purchase Orders/BPA Calls using SAP), type the
HUBZone price evaluation preference percent difference, otherwise skip this
field. Enter whole percent between 00  and 10 .

If: Action for 33D. HUBZone Price
Evaluation Preference Percent
Difference:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract) or
H (Modification)

Field may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip this field.

33A. HUBZone Program is
coded A (HUBZone Sole
Source) or B (HUBZone
Set-Aside)

Percent must be 00 or blank .

Conditional, numeric, 2 positions



Title II, Chapter 5 Section 2
Procurement Reporting System (SF-279)

42 SF 279-B Window Field Instructions

33A. HUBZone Program is
coded C (HUBZone Price
Evaluation Preference) or
D (Combined HUBZone
Preference/SDB Price
Adjustment)

Percent must be greater than 00 .

33A. HUBZone Program is
coded E (Not Applicable)

Percent must be 00 or blank .

33E. SDB Price
Evaulation
Adjustment
Percent
Difference

When 9. Kind Of Contact Action  is coded A (Initial Letter Contract), C (New
Definitive Contract), or D (Purchase Orders/BPA Calls using SAP), type the SDB
price evaluation adjustment percent difference, otherwise skip this field. Enter
whole percent between 00  and 10 .

If: Action for 33E. SDB Price Evaluation
Adjustment Percent Difference:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract) or
H (Modification)

Field may be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip this field.

33A. HUBZone Program is
coded A (HUBZone Sole
Source), B (HUBZone
Set-Aside), or C (HUBZone
Price Evaluation Preference)

Percent must be 00 or blank .

33A. HUBZone Program is
coded D (Combined HUBZone
Preference/SDB Price
Adjustment)

Percent must be greater than 00 .

33A. HUBZone Program is
coded E (Not Applicable)

Percent must be 00 or blank .

33B. Small Disadvantaged
Business Programs is
coded D (SDB Price
Evaluation Adjustment)

Percent must be greater than 00 .

34.
Subcontracting
Plan

Type A (Required) or B (Not Required), or click  to select a code from the

drop-down list. The value selected is entered into the field.

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

34. Subcontracting Plan may be blank.

Conditional, numeric, 2 positions

Conditional, alpha, 1 position
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18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 34. Subcontracting Plan.

34. Subcontracting Plan is
coded B

30. Type Of Contractor must be
coded A (SDB) or B (Other Small
Business).

Contract

35. Subject To
Labor Statutes

Type the labor statutes code or click  to select a code from the pop-up list of

values. Click [OK]  and the value is entered into the field. For information on the
search feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Code Subject To Labor Statutes

A Walsh-Healey Act

C Service Contract Act

D Davis-Bacon Act

E Not subject to Walsh-Healey, Service Contract, or Davis-Bacon Acts

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

35. Subject To Labor Statutes may be
blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 35. Subject To Labor Statutes.

35. Subject To Labor
Statutes is coded A, C, or D

30. Type Of Contractor must not  be
coded M (Domestic Contractor Performing
Outside US).

36. Estimated
Contract
Completion Date

Type the estimated contract completion date (YYYYMM). Ensure that there are
no embedded spaces, hyphens, or special characters. Must be equal to or greater
than 6. Action Date  unless 9. Kind of Contract Action  is coded H (Modification),
J (Termination for Default), or K (Termination for Convenience). Cannot be later
that 25 years after 6. Action Date , except for leases and utilities.

If: Action:

�9. Kind Of Contract Action
is coded Z �

�Field must be completed.�

37. Contractor’s
TIN

Type the contractor’s TIN (taxpayer identification number). Ensure that there are
no embedded spaces, hyphens, or special characters.

38. Common
Parent’s Name

Type the common parent’s name, if applicable.

∇

Conditional, alpha, 1 position

Required, numeric, 6 positions

Conditional, numeric, 9 positions

Conditional, alphanumeric, 30 positions max.
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39. Common
Parent’s TIN

When 38. Common Parent’s Name  has been completed type the common parent’s
TIN, otherwise skip this field. Ensure that there are no embedded spaces,
hyphens, or special characters.

40. Veteran-
Owned Small
Business (VOSB)

Type the veterans-owned small business code or click  to select a code from

the pop-up list of values. Click [OK]  and the value is entered into the field. For
information on the search feature of the pop-up, see List of Values
Pop-Up/Drop-Down List .

Code Veteran-Owned Small Business

A Service Disabled Veteran-Owned Small Business

B Veteran-Owned Small Business

C Not Veteran-Owned Small Business

If: Action:

9. Kind Of Contract Action
is coded G (Order/
Modification Under Federal
Schedule Contract)

40. Veteran-Owned Small Business may
be blank.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 40. Veteran-Owned Small Business.

40. Veteran-Owned Small
Business is coded A or B

6. Action Date must be equal to or greater
than October 2000 (200010).

30. Type Of Contractor must be
coded A (SDB) or B (Other Small
Business).

40. Veteran-Owned Small
Business is coded C

6. Action Date must be equal to or greater
than October 2000 (200010).

41. Multiple
Award Contract
Fair Opportunity

When 9. Kind Of Contract Action  is coded L (Order Under Multiple Award
Contract) and 6. Action Date  is equal to or greater than October 2000 (200010),
type the multiple award contract fair opportunity code or click  to select a

code from the pop-up list of values, otherwise skip this field. Click [OK]  and the
value is entered into the field. For information on the search feature of the
pop-up, see List of Values Pop-Up/Drop-Down List .

Complete only for an initial award of a task or delivery order.

Code Multiple Award Contract Fair Opportunity

A Fair Opportunity Process

B Urgency

C One/Unique Source

Conditional, numeric, 9 positions

Conditional, alpha, 1 position

Conditional, alpha, 1 position

!
Caution
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D Follow on Contract

E Minimum Guarantee

If 18. Contract For Foreign Govt. Or
International Organization is coded:

Action for 41. Multiple Award
Contract Fair Opportunity:

Y (yes) Skip this field.

�9. Kind Of Contract Action
is coded L �

�Starting with action date October 2001,
must be coded A through E.

If the Action Date is equal to or greater
than October 1, 2000, and less than Action
Date October 1, 2001, may be A through E
or  blank.�

Small Business
Competitive
Demonstration
Program

42.
Demonstration
Program

Type Y (yes) or N (no), or click  to select a code from the drop-down list, if a

participating agency in the demonstration program. The value selected is entered
into the field.

If: Action:

9. Kind Of Contract Action
is coded G (Orders/Mod Under
Federal Schedule Contract)
or Z (Initial Load of
Federal Schedule Contract)

Skip 42. Demonstration Program.

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 42. Demonstration Program.

42. Demonstration Program is
coded Y

6. Action Date must be greater than or
equal to 198901.

30. Type Of Contractor must be
coded A (SDB), B (Other Small Business),
or C (Large Business).

42. Demonstration Program is
coded Y and  13. Principal
NAICS Code begins with 233
(except for 233110), 234,
�236, or 237 (except
237210)in the first three
positions �

12. Principal PSC must not  be numeric in
the first position.

∇

Conditional, alpha, 1 position
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42. Demonstration Program is
coded Y, and  13. Principal
NAICS Code is 541310,
541330, 541360, or 541370,
and  12. Principal PSC starts
with C in the first position
or coded T002, T004, T008,
T009, T014, or R404

26. Solicitation Procedures must be
coded D (Architect - Engineer
Procedures).

�If a participating agency � �Must be Y or N except when Item 2
equals 97AB  or Item 9 equals G or Z.�

43. Emerging
Small Business

When 42. Demonstration Program  is coded Y (yes), type Y (yes) or N (no), or
click  to select a code from the drop-down list, otherwise skip this field. The

value selected is entered into the field.

If: Action:

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 43. Emerging Small Business.

43. Emerging Small Business
is coded Y

30. Type Of Contractor must be
coded A (SDB), or B (Other Small
Business).

44. Emerging Small Business Reserve
Award must be coded Y (yes) or N (no).

43. Emerging Small Business
is coded N

Skip 44. Emerging Small Business
Reserve Award.

44. Emerging
Small Business
Reserve Award

When 43. Emerging Small Business  is coded Y (yes), type Y (yes) or N (no), or
click  to select a code from the drop-down list, otherwise skip this field. The

value selected is entered into the field.

Select Y (yes) if the contract action (including modifications) result from an
award that was reserved for an emerging small business concern. However,
contract actions that are modifications within the scope of work of contracts
above the emerging small business reserve threshold shall not be reported as
emerging business reserve awards.

If: Action:

18. Contract For Foreign
Govt. Or International Org.
is coded Y (yes)

Skip 44. Emerging Small Business
Reserve Award.

44. Emerging Small Business
Reserve Award is coded Y

33A. HUBZone Program must be
coded E (Not Applicable).

33B. Small Disadvantaged Business
Programs must be coded F (Not
Applicable).

33C. Other Preference Programs must be
coded D (No Preference/Not Listed).

Conditional, alpha, 1 position

Conditional, alpha, 1 position

!
Caution
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45. Size Of Small
Business

When 42. Demonstration Program  is coded Y (yes) and 30. Type Of Contractor  is
coded A (SDB) or B (Other Small Business), type the code for the number of
employees or average annual gross revenue or click  to select a code from the

pop-up list of values, otherwise skip this field. Click [OK]  and the value is entered
into the field. for a list of values. For information on the search feature of the
pop-up, see List of Values Pop-Up/Drop-Down List .

Code Size Of Small Business

A 50 or Less Employees

B 51 - 100 Employees

C 101 - 250 Employees

D 251 - 500 Employees

E 501 - 750 Employees

F 751 - 1,000 Employees

G Over 1,000 Employees

M $1,000,000 Or Less Annual Gross Revenue

N $1,000,001 to $2,000,000 Annual Gross Revenue

P $2,000,001 to $3,500,000 Annual Gross Revenue

R $3,500,001 to $5,000,000 Annual Gross Revenue

S $5,000,001 to $10,000,000 Annual Gross Revenue

T $10,000,001 to $17,000,000 Annual Gross Revenue

Z Over $17,000,000 Annual Gross Revenue

If 18. Contract For Foreign Govt. Or
International Org. is coded:

Action for 45. Size Of Small
Business:

Y (yes) Skip this field.

SF 279-C Window Field Instructions

The SF 279-C Field Instructions window (Figure 6 ) is used to search/view, add, correct, or
delete SF 279 data. For instructions on this process, see Searching/Viewing An SF-279 Record ,
Adding An SF-279 Record , Correcting An SF-279 Record , or Deleting An SF-279 Record , as
applicable.

Funding Agency

46A. Funding
Agency

If reporting an award done by your agency on behalf of another Federal agency,
type the funding agency acronym (i.e., ARS, APHIS, OO ) or click  to

select a code from the pop-up list of values, otherwise skip this field. Click [OK]
and the value selected is entered into the field. For information on the search
feature of the pop-up, see List of Values Pop-Up/Drop-Down List .

Conditional, alpha, 1 position

∇

Conditional, alphanumeric, 5 positions max



Title II, Chapter 5 Section 2
Procurement Reporting System (SF-279)

48 SF 279-C Window Field Instructions

46B. Funding
Agency -
DODAAC

If 46A. Funding Agency  is a Department of Defense (DOD) agency, type the
DOD Activity Code (DODAAC), otherwise skip this field.

46C. Funding
Agency -
Commerical Item
Category

If 46A. Funding Agency  is a DOD agency and Field 12. Principal Product Or
Service Code (PSC) begins with 70 or D3, or the code is H170, H270, H370,
H970, J070, K070, L070, N070, U012, or W070, type the code for the
commercial item category or click  to select a code from the pop-up list of

values, otherwise skip this field. Click [OK]  and the value is entered into the field.
for a list of values. For information on the search feature of the pop-up, see List of
Values Pop-Up/Drop-Down List .

Code Commercial Item Category

A Commercially Available Off-The-Shelf Item

B Other Commercial Item

C Nondevelopment Item

D Noncommercial Item

E Commercial Service

F Noncommercial Service

46D. Funding
Agency - Reason
For Purchase

If 46A. Funding Agency  is a DOD agency and Field 12. Principal Product Or
Service Code (PSC) begins with 70 or D3, or the code is H170, H270, H370,
H970, J070, K070, L070, N070, U012, or W070, type the code for the reason of
the purchase or click  to select a code from the pop-up list of values,

otherwise skip this field. Click [OK]  and the value is entered into the field. for a
list of values. For information on the search feature of the pop-up, see List of
Values Pop-Up/Drop-Down List .

Code Reason of Purchase

A Convenience and Economy

B Expertise

C Specifically Authorized

D Authorized by Executive Order

E Modification or Extension

F Other

46E. Funding
Agency -
Clinger-Cohen
Act

If 46A. Funding Agency  is a DOD agency and Field 12. Principal Product Or
Service Code (PSC) begins with 70 or D3, or the code is H170, H270, H370,

Conditional, alphanumeric, 6 positions

Conditional, alpha, 1 position

Conditional, alpha, 1 position

Conditional, alpha, 1 position
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H970, J070, K070, L070, N070, U012, or W070, type Y (yes) or N (no), or click
 to select a code from the drop-down list, otherwise skip this field. The value

selected is entered into the field.

Agency Specific

Region/Area
If applicable, type the region/area code.

COID
If applicable, type the contracting officer identification code.

Miles/Acres
If applicable, type the miles or acres code.

Other Programs
If applicable, type other program coded.

49. Contracting
Officer

Type the contracting officer name.

∇

Optional, alphanumeric, 3 positions max.

Optional, alphanumeric, 9 positions max.

Optional, alphanumeric, 7 positions max.

Optional, alphanumeric, 4 positions max.

Optional, alphanumeric, 30 positions max.
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Heading Index

This index provides an alphabetical list of all headings in the procedure. When a heading is referenced, you
can use this index to locate the page number.

A
About SF-279, 1

About This Procedure, v

Adding An SF-279 Record, 15

C
Change Password Pop-up Field Instructions, 19

Changing Your Password, 5

Correcting An SF-279 Record, 16

D
Data Entry Tips, 10

Deleting An SF-279 Record, 17

E
Exiting SF-279, 6

F
Field Instructions For SF-279 Windows, 19

Function Keys, 10

G
Getting Started In SF-279, 1

H
Hint Text, 7

How The Procedure Is Organized, v

I
Introduction, 1

L
List Of Values Pop-Up/Drop-Down List, 11

Logon Pop-up Field Instructions, 19

M
Menu Bar, 8

S
Searching/Viewing An SF-279 Record, 13

Security And Remote Terminal Usage, 2

SF 279-A Window Field Instructions, 19

SF 279-B Window Field Instructions, 31

SF 279-C Window FIeld Instructions, 47

SF-279 Operating Features, 6

Starting SF-279, 2

System Edits, 10

T
Toolbar, 9

U
Using Online Help, 6

Using SF-279, 13
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